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Create Professional flipping book with PDF files
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About Flip PDF Pro

Flip PDF Pro is a much professional program to
help you convert ordinary PDF files into stunning
booklets with amazing page-flipping animations
and sound! Besides original classical Flip PDF
features such as adding background images and
sound, Flip PDF Pro also provides more powerful
and professional functionalities, like embedding
video, audio and links into your flipbook pages,
exporting defined templates and settings to theme
for later easy using, using command line to
automate the creation of the flash eBooks without

opening the Windows desktop application.

Note: This product is distributed on a "Try before-you-buy"
basis. All features described in this documentation are
enabled. The registered version doesn't insert a watermark in

your generated page-flipping eBooks.
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Product features

10.
11.
12.

13.
14.
15.

Convert PDF to Adobe®© Flash® based page-flipping eBooks.

Batch convert multiple PDF files to a single or multiple page-flipping eBooks.
Provide command line version.

Import bookmarks (outline) with PDF, and edit them manually.

Import hyperlinks with PDF, include web link, page link, email link.

Import text so text is searchable, define the minimum search characters.

Add watermarks text, image, dynamic date/ time etc to page-flipping eBooks.
Define quality and size for normal version and mobile version.

Output in different formats: HTML, EXE, Zip, Mac App, Mobile version and
Burn to CD.

o HTML allows you to upload to a website to be viewed online (with title,
keywords and other metadata defined).

o EXE (with setting title, icon and open window size) and Zip allow you to
send to your user by email to be viewed on their computer.

o App (Mac Application) is executable application can be run on Mac.

o Mobile version is to output HTML flipbook which can be viewed on
mobile devices via Browsers.

o Burn to CD allows you to burn to disk so you can send your user physical
media for viewing on their computer.

Apply a pre-designed template.

Preview the output effect instantly.

Add HTML Title in Float template which can be clicked to visit webpage
online.

Add Image or Flash logo to insert before Book Title in Float template.

Define book proportions, margin size, shadow manually.

Replace existing icons on toolbar by editing Icon Flash file.
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28.

29.
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16. Add new icons into toolbar with calling new actions.

Set background color and image.

Insert background music either for continuous play (loop) or for a set
duration.

Set eBook reading from right to left (for Right-to-Left languages such as
Arabic).

Choose hard cover for eBooks.

Set fonts for Flash and Bookmark, Search panel.

Set Page Number Box to show at top or bottom in Float, set start page
number.

Edit pages with embedding links, images, movies, flash, sound or You Tube
video files.

Add Button on pages to open link page, call Javascript action, play
Flash/Video in pop-up Window.

Copy projects from one page to another or all the other pages.

Define the language for your published page-flipping eBook.

Add password to protect your page-flipping eBook.

Different kinds of render engine for choice to avoid distortion for some
special PDF files: SWF, GPL Ghostscript or Inner Library.

Add Google Analytics Support.

Add watermark image or SWF to show on print out pages.

Add Help config to manually define content with using Image or SWF.

Add Minime Style to show page-flipping eBooks without toolbar.

Set permissions for downloading, printing, social sharing, Home, About
button and more.

Edit bookmark manually and set bookmark panel to show on left or right side.
Export and save settings for future uses.

Save and Load your project.
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Page-flipping eBook features

With the page-flipping ebook you have created, your user will be able to:

1.

10.

11.

12.

13.

14.

15.

16.

17.

18.

19.

20.

21.

22.

Drag the corner to flip a page.

Click page shadows to flip a page.
Use mouse wheel to flip pages.

Input password to unlock encrypted pages.

View with important pages pre-loaded to open quickly, no need to wait for
all pages to be loaded.

Use Previous, Next, First or Last buttons to navigate through the pages.

Flip pages automatically.

View flipbook repeatedly.

View page-flipping eBook full screen.

Use page thumbnails to navigate.

Search whole eBook.

Print out the whole eBook or a selected range of pages.

Download the uploaded page-flipping eBook direct from the web site.
Double-click to zoom in or zoom out.

Zoom in/ out both pages.

Manually control zoom in scale in Float template.

Share eBook url via email, Facebook, Twitter, Google, Yahoo, etc.

Turn page-turning sound on/off.

View embedded movie, flash, You Tube video, etc.

Open in the Browser to a specific page by adding a page index to your URL.
E.G. www.yourdomain.com/index.html?pagelndex=4.

Always show in Minime Style with adding a parameter to URL. E.G.
www.yourdomain.com/index.html?alwaysMinimeStyle=true.

View page-flipping eBooks on Mac, iPad, iPhone and Android devices.
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Quick Start

1. Launch the application via the desktop shortcut .HJ ;

2. Click the "Import PDF" icon W 0 enter into Import PDF interface;
3. Click icon to choose PDF file from your computer;

4. Click ImPortlow [;-q to enter into template setting interface;

5. Define parameters for eBooks, such as Book, Tool Bar, Bookmarks, and

then click the "Apply Change" icon ;
%)

6. Click "Convert to Flipping Book" icon " to enter into Output

interface;

7. Choose Output Type from HTML, ZIP and EXE, here take

e

g ".htl'l‘ﬂ

b &
as example;

8. Click to set Output Folder as "C:\flipbook", input File Name

as "demo";

9. At last, click MJ icon to output created page-flipping eBook.

You can open the "flipbook" folder in "C:", there are three files in this folder:

e &

files book.swf demo.html
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Open the "demo.html" file to view your created pOOage-flipping book via Web
Browser, such as Internet Explorer, Google Chrome, Firefox, etc.

& demo - Windows Internet Explorer E@g
- - - .
UO &) caflipbookidema html - 4,‘ % H_, Big o -
e R e
7.¢ Favorites ‘ o
|?demo |_| & - = @ v Page~ Safety~v Tools~ @v #

FUPBUILDER.COM Fur PDF PrO

@ Internet | Protected Mode: Off 3 v H100% v

Interfaces

There are some main interfaces you will see while using Flip PDF Pro as
below shows: Application Options, Import PDF, Template Settings, Edit
Pages, Language Option, Export Theme, Output, Batch Convert and
Command Line.

You can enter into each page to get clear instructions for every detail

option.
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I. Application Options Interface
1. Render Engine Option

Flip PDF provides 3 different render engines for you to create higher quality
page-flipping eBooks, click "Options->Application Options" to enter into "Render
Engine" interface:

Randar Engne

Please selecte a render engine for the conversion

i
SWF

GPL Ghestscript Digwdoad Ghostscrion

F

@ [rner Lirary

SWF: Much legible characters, smaler output size
GPL Ghostsaipt: Higher color ransfer quality

Inner Library: Faster convert speed

Co] [

SWF: Much legible characters, smaller output size
GPL Ghostscript: Higher color transfer quality
Inner Library: Faster convert speed

(Change option when PDF imported failed)

2. Create Mobile Version Option

Five types of "Pages Quality And Size" for mobile version eBooks:

| Pages Quality and Size

Quality And Size:

Higher guality larger file size
High quality large file size
Fiight valies 1 Medium c_|ua||ty I'I1Ed||.||'!1 file size
Ak but require m Low quality small file size
Lower quality smaller file size
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Il. Import PDF Interface

|g) Import PDF s

Source PDF Flie

: \sers\Administrator \Desktop\source . pdf] Browse.. l I Open it |

The Page Ranges to Import ‘Watermark
© Al pages L Place a custom text or image
(@ Customrange:  1-10 Example: 1,3,5,9-21 ~ Watermark(Stamp) to the file(s)
y
[¥] Quickly import {Only impart 10 pages to initial preview) Set Watermark
Page Quality
Quality And Size: [High quality large file size VI

44 High values produce better page quality but require more disk space and more time to download.

[¥] 1mport bookmark [¥] Impart links [V]Enable search

Import Now Cancel

Panel Description:

1. Source PDF File:

Click this icon to open the PDF file you want to convert;

Dk View content of added PDF file to clarify before converting.

2. The Page Ranges to Import:

© &ll pages Convert all pages to page-flipping eBook;

@ Custo A E ie51,3,5:9-21 .
i e Convert defined range page;

[¥] Quickly import (Only import 10 pages to initial preview) Just preview effect on first 10 pages

3. Watermark
Add image or text watermark to flipping pages.

| ing Wi . -
[l Applying Watermark Check this option first to choose default stamps or add new ones:
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Page-flipping eBook

[E)

Edit /
Add text stamp

Add image stamp

Delete

Move down

D ¢ X M &

Move up

4. Page Quality
There are five types of "Quality And Size":

Medium quality medium file size
Low guality small file size
Lower guality smaller file size

5. Other Options:

TSI If your PDF file contains bookmarks, check this option to use in output

page-flipping eBook;

Import finks If your PDF file has links, check this to enable in flipbook;

SR e Check this option to enable search functionality in created flipbook.

At last, click icon to enter into template setting interface.
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lll. Template Settings Interface

File Convert Options Help

E& Import PDF ‘ @ Apply Change ‘ _ Edit Pages ‘ % Convert To Flipping Book ‘

Design Setting |Bogh’|1ark|
o S P —  S—

Templates

T HEs g

Please customize the flash template here

[ElBoak |

FuLip PDF PrO

Book

g Book Configuration

Flip PDF Professional provides three different templates in the program: Classical, Float and
Spread.

Each template contains some unique settings, the below instructions will show you details
about the default three templates.

The design setting interface contains below main parts:

Choose Template; Book; Sound; Tool Bar; Bookmark; Initial Show; Links; Language;
Security Settings; Font; Google Analytics ID; Start Page Numbering; Minime Style.

1. Choose Template
Templates

‘ iCIassical ‘H E

Please customise the flash template here

i Classical |H

Click ‘

icon to select templates from below interface:
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- Choose a fipbook template here. (Double -click to make a quick selection)
B (More and more templates will be provided in future,)
i Get More Themes Onfine
Templates — — s =
[ Classical
= o~
SN Float
[iH| Spread — — Bk B
= "m - =
o »
4 - — :
Darse Fiorig Flowred
e |
Lo || concd |

H Click this icon is to save current settings as a TXT file for later uses;

i )
& Click this icon is to import stored setting file at once.

2. Book Panel

BlBaok [ )
Baok Title | Fipul..
The Book Logo C WUsers\Ad...
Hide Book Frame Bar - fI‘_-Jo

_ Retain the book to center Mo

EHBook Proportions }
Top Margin |10
Bottom Margin |10
Left Margin |30
RightMargin |30
Fiash Window Color | II0x021A25
~ Page Background Color fI:lEfoFFH"f

EPage Shadow |

HBackground Config |
Right To Left Mo
Hard Caver Mo
Flipping Time |0.8

(1) Book Title & Logo (only can be set in Float Template)
Customize book title and logo for showing on the top of your flipbook. You are enabled to
set the book title as HTML format text.

For example: <a href="http://www.flipbuilder.com' target='_blank'>FLIPBUILDER.COM</a> |
<font color="#ff0000' size='14'>Red Color</font>

lqu_lg'I:lﬂe = | <& href="...
The Book Logo |C:\Users, ..

§ FLIPBUILDER.COM |
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(2) Hide Book Frame Bar

| Hide Book Frame Bar Yes ﬂ

If don’t want to show the book frame bar, choose “Yes” in this option.

(3) Retain the book to center
| Retain the book to center [Yes |

If you select “No” in this option, the eBook will be shown on the right-side. This setting is for
embedding special background image, such as advertisement or company log.

(4) Book Proportions

EHBook Proportions
Page Width 1052
Page Height |1500

Please note that the values are not fixed in pixels or inches, they just represent a ratio for
"Page Width: Page Height", and the book size will be changed depend on your Explorer
Window Size.

(5) Book Margin

A. Book Margin (set in Classical Template):

Book Margin 50 |

¥

__Margin

g— I\/Iargin

"Book Margin" refers to the distance between the book and the toolbar.

B. Top/ Bottom/ Left/ Right Margin (set in Float/ Spread Template):

Copyright 2010 by FlipBuilder.com
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Bottom 4

(6) Flash Window Color

Flash Window Color

| 9 0500001~

D

This color will be applied on all flash windows, such as the book window, "Help" window,
"Print" window and so on.

(7) Page Background Color

When load pages, or if the page number of your PDF file is odd, then the page (the last page)
will show with the "Page Background Color".

Copyright 2010 by FlipBuilder.com
-13-



" B C;.
= - v

PDF to Professional Page-Flipping eBook Utility
User Document

(8) Page Shadow

BlPage Shadow :
Leftpage Shadow |50
Right page Shadow |25
Page Shadow Opadty |0.5

Lefe page Shadow

Right page Shadow

The value also takes the value of Book Proportions as reference, and the value interval of

"Page Shadow Opacity" is "0~1", the larger value refers to the deeper shadow color.

(9) Background Config

A. Background Color:

ElBackground Config
BElBackground Color |
Gradient Color A | CoxFFFFFF
Gradient Color B | 0x000000
Gradient Anale |90
/Gradlent Color A

Gradient Color B

Define background for your flipbook with gradient color or pure color (the same color for

"Gradient Color A" and "Gradient Color B"). Gradient Angle is the angle between the two

colors.

B. Background Image setting in Classical and Spread templates:

EBackaround Image
Image File E\1 (7).ipclPH
Image position Scale to f

Click the icon " ==J" to choose background image from your computer, and there are 11 kinds
of "Image Position" for you to choose: Scale to fit, Fill, Top Left, Top Center, Top Right,
Middle Left, Middle Center, Middle Right, Bottom Left, Bottom Center and Bottom Right.

Copyright 2010 by FlipBuilder.com
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C. Background Image setting in Float template:

BlBackground Image
Cuter Image File E:\Prugram.,l
Image position Scale to fit
Inner Image File E:\Program. , |
Image position _Scale to fit

The Float template enables you to add two background images: Outer Image and Inner
Image. You can make Inner background image to show special information, such as
advertisement or company logo, etc. There are also 11 kinds of "Image Position" for you to
choose: Scale to fit, Fill, Top Left, Top Center, Top Right, Middle Left, Middle Center, Middle
Right, Bottom Left, Bottom Center and Bottom Right

(10) Right to Left

If the language of your file is read from right to left (such as Arabic), then choose "Yes" in
"Right to Left" option:

| If{ightTo Left |Yes

(11) Hard Cover

If you want create hard cover effect (a book bound with rigid protective covers) for your
flipbook, choose "Yes" in "Hard Cover" option:

Hard Cover |'fes

Copyright 2010 by FlipBuilder.com
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(12) Flipping time
Flipping Time 0.6 Sets page flipping time in seconds according to your

needs. (Recommended second value is 0.6)

3. Sound Panel

ElSound
Enable Sound Enahle

| Sound File hple 3. mp3) J
Sound Loops ]

If you want to add background sound to your flipbook, such as a song or other audio file, set
"Enable Sound->Enable", then click " =" icon to choose "Sound File" from your computer,
then set "Sound Loops", "-1" stands for playing the sound file all the time while viewing
flipbook, other value (N>0) stands for the times of playing the sound file.

4. Tool Bar

[ETo0l Bar
Icons File(SWF Only)
Add Icons Settings

Icon Color [lacff
HZoom Config
EHPrint Config

Search Button Show |

Search Highlight Color [CJoxffoo

Least search characters |3
EDownload setting

Full Screen Button Show
HHelp Config

Social Share Button Show

[HShare Button

HHome Button

[H About Button

[ Auto Flip
Tool Bar on top False
Page Mumber Box On Bottom |False

(1) Tool bar (only in Classical Template)
Tool bar Show

Show or Hide Tool bar in created flipbook.

(2) Icon File
Select the Tool Bar Button to replace with your own icon.
Icons File(SWF Only) [crsers..)
More details please view here:
http://www.flipbuilder.com/support/how-can-i-replace-the-icons-on-the-flash-toolbar.htm

(3)Add Icons Settings
If you want to add some other kinds of buttons which the program doesn't provide, you can click
"Add Icons Settings->..." to enter into "Icons Settings" interface to add new icons on tool bar:

Copyright 2010 by FlipBuilder.com
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: Add Teons Sattings
&/ lcons Sattings m

Config icons for toolbar

Achon Typs ACDon Conlent
oy ==

Add Toon
[icon Fie

Souroe Fle:  C\UserslAdmirestra bor \Deskion Plew folder image: Erowse...

Button Info
Capion: Go To Page &
fcon Button Achon

& o in page Coen a bk Call Javascript function

Page Index: &

50 To Page &

You can define the link action as "Go to page", or open an online webpage, or even "Call
Javascript function" to carry out your wanted interactive functionalities via defining Javascript
function yourself.. After your "Apply Change", the new added icon will show in the toolbar. (More
details about Call Javascript function will be introduced in the part of "Edit Page->Add Link".)

(4) Icon Color

| Icon Color \[JoxFrrr||
7?7 Q r = a
(5) Zoom Config
BzoomConfe |
. Zoominensble  |Yes

Zoom Scale i1. 5

To Enable Zoon In functionality, choose "Yes" in "Zoon in enable", then set "Zoom Scale", the
value is the times between zoomed page size and the current page size.

Copyright 2010 by FlipBuilder.com
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(6) Print Enable
Print Enable s

Choose "Yes" in "Print Enable", then click icon to set print page range as below:
= Pnnt ‘

=) Print AN Pages
_J Print Current Page

_) Print Range

Example; 2,5,8-26

& Print

(7) Search Button
Search Button [show
Search Highlight Colar [loxFFFFa0
Least search characters |3

Select "Show" in "Search Button" (make sure you have check "Enable Search" option in
"Import PDF" interface), then define "Search Highlight Color", after clicking "Search" icon

, you will see a popup box to input search words, then click Enter or "Search" button,

you will get the below searching result:

(8) Download setting

ElDownload setting
Download Enable Yes
| Download URL 2DFDemo. pdf

If you want your flipbook readers to download the PDF file or the flipbook directly from your
website, select "Yes" in "Download Enable" option, then input the Download URL directly,
you can use absolute path like
"http://www.flipbuilder.com/flip-pdf/example/files/download/FlipPDFDemo.pdf" or relative
path like "/files/download/FlipPDFDemo.pdf" (make sure you have uploaded the PDF to the
same path).

Then readers can click the icon n to download your uploaded PDF file directly.

Copyright 2010 by FlipBuilder.com
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(9) Full Screen

To enable "Full Screen" functionality in output flipbook, select "Show" in "Full Screen
Button" option: Full Screen Button | Show

rm'l N
Then you can click icon to view flipbook in Full Screen, click icon or "Esc"

button to exit from the Full Screen.

Or if you want to show your flipbook without Tool Bar while showing in Full Screen mode,

you can set "No" in "Full Screen without Tool Bar" (just in Classical Template):
Full Screen Without Tool. . | Yes

(10) Help Config

ElHelp Config _
Help Button |Shaw
Help Content File |-type.png =
Help Window Width | 400
Help Window Height 450
Show Help At First |Show

To show tips about viewing flipbook, you can set "Show" in "Help Button" option, and you
can define Help Content manually by inserting "Help Content File (image or SWF)", also
enable to define the Width and Height of the Help image or swf. If you set "Book->Retain the
book to center->No", you can set "Show Help At First->Show" to display the Help Panel with
the Book as below:

_.;_n..‘-‘?aj_ﬂ

Hth: : . FuP PDF

Double-click to 2oom infzoom out;
Drag the page corner or
Use mouse wheel to flip pages.

You can also click the button to view the same Help page in pop-up window.

(11) Social Share
If you want your flipbook viewers to send the link to their friends or clients via Facebook,
Twitter, Linkedin, Google, Yahoo and so on, you can add a Social Share button in your
flipbook for readers to send out your flipbook link immediately:
| Socal ShareButton _[show |
Copyright 2010 by FlipBuilder.com
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The readers just need to click the "Social Share" button ﬁ, then the below window will pop

up for them to choose share channel:
Social Share

Microsoft Word - demo3.docx I_j Eachinok ™ Twitter
in Linkedin Google

Yahoo

E-\—?‘ StumbleUpon
A Aele

m Moo

& Technorati + More

Link: http://www flipbuilder.com/flip-pdf/example/

(12) Share Button
If you want readers to share via Email, you can enable "Share" feature as below shows:

Eshare Button
Share Button Show
Email Subject Rear my fii...
Email Body {link

When the viewers click the share button E, they will enter into the Email interface with

the link of your flipbook in the Email body.

(13) Home Button

You can add a home buttonm to help reader to click and go to your website directly:

HHomeButton
. Home Button Visible  |Shaw

(14) Auto Flip

To auto flip your eBooks, you can set "Yes" in "Auto Flip->Enable" option; then define the
Flip Interval (seconds of staying on each page); the value of "Play Count" stands for the times
of auto playing the eBook, and "-1" stands for playing forever (after clicking the Auto Flip

button “, the flipbooks will be flipped by staying 3 seconds per page); if you want to

auto start and flip the eBook after opening, just set "Auto flip when start up->Yes":

R il

. PayCount ot
Auto flip when startup |Yes

Copyright 2010 by FlipBuilder.com
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(15) Tool Bar on Top(set in Float Template)
If you want to place the toolbar in Float templates on the top of the flash eBook, you can set
"Tool Bar on Top" as "True":

Tool Bar on top True

(16) Page Number Box on Bottom(set in Float Template)

Page Number Box On ... [True

5. Initial Show (set in Float/ Spread Template)

You can show Bookmark panel or Thumbnails panel on the flash page at the beginning, just
select "Bookmark" or "Thumbnails" in this option:

For Example, select "Thumbnails": ] Bk Show Ttk |

Then you will get flipbook shown with below initial interface:

Fur PDF Pro

Copyright 2010 by FlipBuilder.com
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6. Bookmark

Desin Setting | Backmark |

ElBackmark
Font color W o00a000
Background color D SE AFF i
Background sipha 1
Alwaiys Show Bockmark | True

Panie Position Left

[Page | rrpeecon  FUP PDF PrO
1
] A 3 3
[IF'] Abbut pechase 5
ﬁlli

1
| LA s g bk e

Title:  Other progucis

Bage: &

In "Design Setting" panel (only in Classical Template, in other templates, the colors will be
adjusted automatically based on your defined flash window color), you can set "Font color",
"Background color", "Background alpha" (refers to the background opacity, value interval:
0~1, "0" stands for the background is totally transparent), "Always Show Bookmark->True/
False" and "Panel Position->Left/ Right".

In "Bookmark" panel, if you didn't check "Import bookmark" option in "Import PDF"
interface, or you want to create new bookmarks for your flipbook, you can add bookmarks
even sub-bookmarks here, click "Add" icons and then input "Title" and "Page".

When click the bookmark button , it will popup the bookmark panel immediately, and

click on those bookmarks, it will jump to the defined page automatically.

7. Links

FLip PDF PRO

BlLinks
Mouse over color
Link alpha 02
Open Window |Blank
Enable after zoomingin  |Enable

Creste your prafessionz! fipping ook with POF files

If you have check "Import links" option in "Import PDF" interface, or add links in "Edit Page"
interface, then you can define settings here, choose "Mouse over color", "Link alpha" (refers
to the link area opacity, value interval: 0~1, "0" stands for the area is totally transparent),
and "Open Window->Blank/ Self". The links also can be clicked after zooming by setting

Copyright 2010 by FlipBuilder.com
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"Enable after Zooming in->Enable".

8. Language

|_Lanquage |Enalish =]

You can set language for showing tools or tips in your created flipbook, and here is the

specialized instruction page for setting the "Language Option".

9. Security Settings
[ Security Settings Single Pass ]
If you want to protect your flash books with passwords, you can click "..." icon to enter into

"Flash Security Config" interface:

i securty cont S ==

hoites
Srghe Passveord option mesns That uses nead the pessward o visw the fash baok.

Exclude Front Pages option i to sef a page number, all latter pages can't be
viewed ywithout mputbng password,

Secundy Type
T Hio Gty
1
\ |
L:\\ & Srgle Password: 123458
Protect Fags Range
& Pages

(o] [

Select "Security Type->Single Password", and input passwords into the box (there is no

restriction on password format at present). You can also set "Protect Page Range" as "All

Pages" or the latter pages after a defined page number. (Tips: The program utilize RC4

algorithm to protect eBook pages, the eBook content pages will show nothing without

permission.)
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10. Font

Search Result Font Color | (]oxcFFIFC
Search Result Font | @Arial Unicode MS

A Q| Search x

Product features program Q\
N d: 4 o

. Font 52 . v 5
Font Color | L10xFFFFa0
Button Font |Britannig/Bold
|Window Font Calor L | A
WindowFont
Bookmark Forit Color
Bookmark Font & | i | Paged:programming tricks need!

i PageZ: any programming work

greements Pageb&.program to convert unlimited PDF
1 Order files to to
Page&:.any programming work

A\

If you want to change fonts of toolbar buttons, flash windows even bookmarks or search
panel, you can set font types and colors in Font Panel.

11. Google Analytics

Google Analytics ID

In the HTML output format, you can add statistics by using google analytics. You can get
more information about Google Analytics ID from http://www.google.com/analytics/ .

12. Start Page Numbering

If you don't want to count in the cover page, table of contents pages into the actual page
numbers, you can set "Start Page Numbering" as the number you want to start to number from.
For example, you set "Start Page Numbering->5", then you will get page number box like below:

Start Page Mumbering ;_5 e o Pages: 1{5/8)

13. Minime Style

If you want to present Page-flipping eBook pages directly without showing toolbar, especially
when you want to embed eBook into a small area in existing webpages, then you can use this
"Minime Style":
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Minime Style
Use Minime Style \Yes
Width | 400

< Cmsts renl Fppang efface book In

o PRz T, ] L DO

Click to view in fullscreen

T Sral 12 gy I 12 o,

The Minime Style will trigger when the Width or Height of the Flash Container is less than the
defined value. You can also always show the page-flipping eBook in Minime Style with adding a
parameter to your URL like this: www.yourdomain.com/index.html?alwaysMinimeStyle=true .

14. Export Theme

If you want to save the current template settings as your own style template for later uses,
you can click "File->Export current settings as Theme" button to storing all current template
settings, include the background images, margin values, toolbar buttons and so on.

Then when you want to use later, just click "File->Import Themes", the theme will be added
to the templates selecting interface.

IV. Edit Pages

Now you can use Flip PDF Pro to edit imported pages directly, no matter you want to add link,

T ;
! g.__x Edit Pages .

video, sound or image file.

Just click "Edit Pages" button to enter into the editing interface:
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[E] Flip Page Editor e—ms=ls

LL]
b
m-
D)
2]
@)

You can insert links, images, sound, movies even buttons with calling many functions to the pages
as you will.

1. Add Link

Click the icon and then draw a link box on the area you want to add link, then define

properties in below panel:

Link Properties

Over Color: . Over Alpha: ™ Down @ Up ® Move
Down Color; [ Down Alpha: B ® Over ® Out

Mormal Color: MNormal Alpha:

™ Go to page @ Openalink @ Call Javascript function

URL:

Link Target: m E M

You can define the link action as "Go to page", or open an online webpage, or even "Call
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Javascript function" to carry out your wanted interactive functionalities via defining Javascript
function yourself.. For example, you can show a pop-up light box while readers clicking some
image on page, or pop-up a questionnaire or other Web Form by clicking some text. Just make
sure the parameter you set in "Function" can be called in from HTML page.

Example: Check "Call Javascript function" as action type, then input Function as
"testLightBox("Hello, this is a test"):

® Down © Up ™ Move

™ Over ® out

Go to page ™ Openalnk © Call Javascript function

Function:

And then make sure the Javascript wrote into the index.html page as below image shows (the
same as you set in "Link Function"):

<head>
<title>FDF-BenU brochure 2010-100dpi</title>
<meta http-equiv="Content-Type™ content="text/html; charset=utf-&" />
<meta name="Keywords" content="" />
<meta name="Description" content="" />
<meta name="Generator™ content="[Flip PDF version 3.0] at http://flipbuilder.com/™ />
iminate any de T rgins/t g a T ght

<!— Include

<3tyle type="text/cs3™ media="screen">
html, body | height:100%; }
body { margin:0; padding:0; overflow:auto; text-align:center;
background-color: #Lfffff; )
#flashContent [ diasplay:none; }
</atyle>

<script type="text/]Javascript™>

-
1runction testLightBo%IstrFrDmElaah]{
TR =

do the things you want here!
alert(strFromFlash);
}
</script>
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2. Add Movie

Click icon and then draw a box like below on the page you want to insert FLV movie:

stop movie actions, etc.):

Movie Properties

Select FLV Maovie

Player Skin Color:

Play Movie: When click Play button

When dick Play button

Stop Movie:
When enter the page

When leave the page

3. Add Image

Click the icon E to draw image box and then select image (.jpg, .png, .bmp), set options:

Image Properties

Select an I.iﬂ'ag'e'

4. Add Sound

Click the icon u to draw sound box and then select sound file, set other options:
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Sound Properties

5. Add Flash

Click icon . to insert SWF flash into your defined area of flipbook page:

6. Add Button

Click icon n to draw an area for inserting your image or SWF button file with calling actions.
The actions contain "Go to page", "Open a link", "Call Javascript function" and "Open Flash
Window". The before three actions are the same with the actions in "Add Link", the "Open Flash

Window" can help you to play SWF Flash or FLV Video in the pop-up window:
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Button Properties Open Window Action Properties

Wi W Iy " 4 &
Select an Icon{SWF, Image)| Window Type: Open the window to play 3 video

Window Content: Selact The He

Window Caption:

™ Do - . Mo
LS Up e Window Width: Window Height:

® Over ® Out

® Gotopage ™ Openaink ® Call Javascript function

© Open Flash Window

7. Add You Tube Video

Click the icon Eand then draw a box on the page to insert You Tube video into pages directly.

You just need to define the video ID directly. For example the video link is:
http://www.youtube.com/watch?v=xKA6WIqjB7c, then the video ID is " xKA6WIqjB7c".

YouTube Video Properties

Video ID:

Video Parameters:

Play Movie: When dlick Play button

When dick Play button

Stop Movie:
When enter the page

When leave the page

8. Copy and Paste
If you want to add same links, images, videos, audios to different pages, you don't have to repeat
the "Link/Image/Video/Audio added" operations once and once again, just select the link object,

click the copy button and then go to the other page to click the paste button Edirectly.
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9. Apply All
If you want to use the same link, video, audio, image or button on all pages (or all odd, even
pages, or your customized pages), you can select the object and then click the Apply All button

B, then define the apply page range in pop-up window like below:

Page Ranges

™ Al Pages ® 0Odd Pages #® Even Pages

® Custom range:

After adding links, flash, movie or sounds, you can click the icon to save the settings and

back to the template setting interface.

V. Language Options Interface

Click "Option->Flash Language", you will enter into the Language Settings interface as below
shows:

” Language Settings _ ﬁ ﬂ

You can new or edit & lenguage for the Aash flipping book.
The Labled column below is the string that will be displayed in the fiash.
w The language wil be list in the flash template settings

Language Name: |Chinese = [ Mewionguse | [ Mpeete | [Bssvess..| | Giiesd.., |
Language Settings
Label Labled - et |
Frst Bution B0
Next Page Button T—m B
Last Button mE—&
Previous Page Button B
Download Button T8
Print Button $1ED0
Search Button B
Book Mark Button B
Help Button #eh
Enable FulScreen Button £
Disable Fullscreen Button BR
|G e o Bt TEES X

Panel Description:

As the tips explaining, the "Labeled" column lists the buttons and instructions on Flash books
in defined language, and the program provides you five different languages for you to use:
English, Chinese Arabic, French and Greek.
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Language MName: |w vil
Arabic
Chinese
Endglish
French
Greek

You can also add other language for your own uses:

FEI Mew Language M-‘
Hew Language |
Name; Frendh
Copy From: | English bt
Lo ) | g |

i

Click "OK" to save the new language in the list;

2. Choose the first label and click "Edit" icon, define new language text in "Labeled" box,

then click "Save And Edit Next":
Language Settings

| Label

Kext Page Butbon

| LastButton Last £ Edti Language Item
Priévions P Buttan Previous P2
Dowrdcad rnm Dowrload || EHtLanauage Sting |
Print Button Print |

| Search Buttan search | Label:  FrstBubton
Back Mark Button Book Mark

| Heip Button Help | |abeled;  Premsbre|

| Enable Fulseraen Buttan Enabie Fulls
Disable FullScresn Button Disable Fuld!
| Gy el ey B etbenen Semmyd P

| svesnceatnet | [ ox | | ganoe

b |

3. At last, you can get all Labels translated into your new language as the images shows:
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Label

First Button

Mext Page Button

Last Button

Previous Page Button
Download Button

Print Button

Search Button

Book Mark Button

Help Button

Enable FullScreen Button

Disable FullScreen Button
Zovind Fin Bridtan

Labled

Premigre

Page suivante
Dernigre

Page précédente
Telécharger
Imprimer
Rechercher
Réservez Mark
Aide

Activer FullScreen

Desactiver FullScreen
i B wried

Delete
You can delete unwanted language:

Or save your edited new language file as XML or TXT file:

Load language file saving before for current using:

After setting template and language, click

apply the settings.
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E R —— _—
U Cutput Option ﬁ
Output |
Output type
’3 @ *html *zip @?% ) =exe i‘, ) *.app
Also Make Mobile Version  Make output page-flipping eBook works on iPad, iPhone and Android mobile devices
Path

File Mame: index html

Options

HTML Title: demao

[l Burn to €0

Make it automatically play the fiipbook in CD

Output Folder: C:\Users\Administrator\Desktop |u‘:'li|:|hook

(o] o]

=r |0;1:0,G; PLDS  DVD-ROM DH-16D355 VD15

[ Cancel l ’ Lonvert

Output types:

1. HTML

;\3’ @ =html

This output type is for uploading created page-flipping ebook onto websites:

You can define HTML Title and other properties by clicking "Advanced" button:

Options

HTML Title: demo

Set Keywords, Description or even Script in the below interface:
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EJ Advanced Settings ﬁ

HTML Advanced Settings ; |

HTML Meta Settings

Title: demo

Keywords:  pdf, flipbook, page-fipping, eboak, online, website, flash, background, music

Description:  This page-fipping eBook shows you the stunning flash effect on FDF pages, a

Add Scripts
‘You can put some trackng
code such as Google
Analytics here.
Need dosed <soript>tag!
|
o | [ concel

@ *.zp

=t

This output type is for compressing the created files into an integral ZIP package which can
be sending out as attachment directly. You can also define HTML Advanced Settings by

clicking "Advanced" icon: &

Your recipients just need to uncompress the ZIP file and then they can view the HTML
flipbook instantly:

J files
'E;dema.html

book,swf

This type is for outputting flipbook as a single executive file, easy storing and easy viewing:

e—
=
| demo.exe

You can also define Icon and Opening Window Size in Advanced Settings:
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"[B] Advanced settings =)

Exe Advanced Settings
Exe Window Info

Caotion; demo
Tcon: Jﬁl wo | | pefadt |
Window Size Option

[Madimized Custom Size

@ Ful Soeen

[ Cancel | ‘

If you want to make executable application to run on Mac devices, you can output as
"* app" format.

5. Mobile Version
[¥] Alzo Make Mabile Version

You can even output Mobile Version while choosing HTML or ZIP format at the same time.
After creating mobile versions, you just need to output all files online (including HTML, SWF,

"files" and "mobile" folders), then you can visit the flipbook page through your mobile
browser.

6. Burn to CD

[ Burn to €0

CD Writer (0:1:0,G: PLDS  DVD-ROM DH-16D55 ¥D15

Disc title: Page-Flipping eBook

After choosing output type, then check the option "Burn to CD", set "CD Writer", define
"Disc title".

How to make created eBooks available for others online, more details this support page:
http://flipbuilder.com/support/how-can-i-share-my-created-ebook-online.htm .

At last click @button to output flipbook in your defined type.
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VIl. Batch Convert Interface

[¢) Batch Convert JE=REE
#}  Add PDF Documents

| g acdFies ||y Add Eolder ! 5 Clear Al

Name Path

JFlip Printer E:\Usefl Documents\PDFs|Fip Printer pdf
-Fip PDF Et\Jseful Documents\PDFs Fiip PDF.pdf
JLFip wiord £:\Useful Documents\PDFs Fiip Word.pdf
-Fip PPT E:\Useful Docments\PDFsFiip PPT. pdf
) Settings

Output Settings | PDF Settings |

Output type

D oum

Also Make Mabile Version  Make output page-flipping eBook works on iPad, iPhone and Android mobile devices

Path
Output Folder: C:\Users\Administrator\Desktop\fipbook Open
File Name: {PDF FileName} « html pattern
Flip Printer
Options
HTML Title: My FlipBook - {5 Advanced
My FlipBaok

["] Merge All POF Files to One FlipBook

) Convert to Flash

}I} Convert to Flash

1. Add PDF Documents
,_E'i,a Add Files |

Click this icon to add PDF files from computer;

|.“-Q' A E°|der.| Click this icon to add all PDF files in the folder (include sub-folders).

You can also remove some unwanted PDF, move up/ down files, or clear all documents.

x Remove %f Clear Al f@-‘- Maove Up @' Maove Down

2. Settings

(1). Output Settings

i. Choose Output Type

Quiput type

@ oo

[¥] Also Make Mobile Version  Make output page-flipping eBook works on iPad, iPhone and Android mabile devices

ii. Choose Output Path

Path

Output Folder: C:'\Users\Administrator\Desktop l Browse... J[ Open
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You can also define output name pattern with FileName, Title, Subject and so on:
File Mame: L*J

{PDF Title}
{PDF Subject}

EEDF .ﬁ.uﬂmri
POF FileName

And after defining the File Name, you can preview the result example below:

File Mame: {PCF FileMame} Flipping Book

Flip POF Flipping Book

iii. Define Output Option

Options

Caption:  {POF FileMame} - 3¢ Advanced

Flip POF

Click "Advanced" icon to define Keywords, Description for HTML flipbooks, or define Icon,
Window Size for EXE flipbooks:

‘J Advanced Settings o] U Advanced Settings hﬁ!ﬂ
HTML Advanced Settngs | [ 2w advanced Setings |
HTML Meta Settngs Exe Winckn Info
Imes Goma Captan: demo
Kewymords: 0¥, fiobook, page-fiopng, ebook, oniine, website, fash, background, music 2 :
_— Leon: Tore el | it |
Descripbion: | Mhis page-flpong eBock shows you the sturning flash effect on POF pages, & -y e
Add Sopts Windw Size Coben
Yiou can put some tradeng Manmazed Cystom Size
code such a2 Google
Analytics here.
Meed dosed <soript>tag! 854 500w
7 . | -
L

iv. Merge All PDF Files to One Flip Book

[#]Merge All FOF Files to One FlipBook:

(2). PDF Settings

i. Page Range

The Page Ranages to Import
71 All pages

© Custom range;; 25 Example: 1,8-21,30
You can convert "All pages" or just "Custom range";
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ii. Watermark
Watermark
_n_"" -~ Place a custom text or image

'!.y Watermark{Stamp) to the file{s)

Click "Set Watermark" icon to enter into "Watermark" interface:

Option - m

Watermark
(¥] Applying Watermark
Watermark Name Type =
Eaf s
[T A Text -FinaL Text ey
] A Text - COMPLETED Text Lo
] A Text-CRAFT Text

!l £ A Text - FOR PUBLIC RELEASE Text &

il A Text - INFORMATION OMLY Text =
[T] A Text -MOT FOR PUBLIC RELEASE Text
[T A Text -NOT APPROVED Text 3 3¢

N F A Text - Company(Tie) Text =
] A Text -LOGO (eft-tog) Text &
1 A Text -LOGO (Right-Top) Text
] A Text -LOGO (Left-Bottom) Text -~
[ A Text -LOGO {Right-Bottom) Text
[ A Text - Dynamic - (titie) Text

i [[] = tmage -L0GO Image =

‘ Lo | [ conce

Check "Applying Watermark" option, then you can choose default stamps, Edit them, or Add
Text Watermark, Add Image Watermark, Delete, Move Down/ Up.

iii. Page Quality

Medium guality medium file size
Low guality small file size
Lower guality smaller file size

Choose quality and size type from listed five kinds.

iv. Other Options

[&] tmport bookmark If your PDF file contains bookmarks, check this option to use in output

page-flipping eBook;

V] mport finks If your PDF file has links, check this to enable in flipbook;

Enable search  cpack this option to enable search functionality in created flipbook.

-;} Convert to Flash
At last, click icon to batch convert listed files together.
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VIll. Use Flip PDF Pro in Command Line

You can also use Flip PDF Pro in Command Line.

Flip PDF Professional Command Line Usage:

PTCMD.exe [Options]
-f<PDF File>
-o<output folder>
-t[html|zip | exe]
-n<OutputFileName>
-c<caption>

-s<Flash settings>

-r<page range>.

-g<import quality>

-R<GS|SWF|LIB>

engine)

-b<Y|N>

-I<Y|N>

-S<Y|N>

The source PDF file.

Specify the folder for the output files.

Output type. Default is html.

Specify the name for the output file.

Caption for HTML or EXE.

Value format is:<Template name>#[<Theme name> |
<txt_settingfile path>].

<Template name> could be: Classic, Float, Spread.

<Theme name> are list in the "Select a template" window,
such as Blank,Blues,Nostalgia.

<txt_settingfile path> is the file that you export

with "Save the template settings" function

The page range that you want to import from PDF File.
Range value string like:2-15,33,35-36,0r All.(Default: All)

Count be 5,4,3,2,1.5 specify the higher quality larger file
size;1 specifies lower quality smaller file size.(default:4)

Render engine options. (Default: GS, Ghostscript render

Import bookmark yes or no. (Default: Y)
Import links yes or no. (Default: Y).

Enable searchable or not.(Default: Y, enable searchable)
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-k<html key words> Set the keywords for html output file.
-d<html description>  Set the descriptions for html output file.
-j<html javascript> Set the javascript for html output file.
-i<icon file path> Specify the icon path for exe output.
-w<window size> Specify the size of exe window.

Value could be: M,F, or some string like:800,600.
(width is 800,height is 600).

Examples 1:
PTCMD -f"C:\input.pdf" -0"C:\outputfolder" -n"index" -thtml -c"Title"
-s"Float#c:\my_ebooksetting.txt" -r"1-8,9-14,42" -q4 -R"SWF" -bN

Examples 2:
PTCMD -f"C:\input.pdf" -o0"C:\outputfolder" -n"ExeFileName" -texe -i"C:\app.ico"
-c"Title" -s"Float#Blues" -r"All" -g5 -R"GS"

Examples 3:

PTCMD  -f"C:\input.pdf"  -0"C:\outputfolder" -n"index" -tzip  -c"Title"
-s"Float#Blank" -r"All" -g5 -R"GS" -k"html key words"\

Return Code:

Success

Input file not found

Parameters are invalid

Failed to load PDF

Failed to import bookmarks

Failed to import links

Failed to import searchable information
Failed to save the output file.

Yoo hsEWNRE
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License Agreements

All copyrights to Flip PDF Pro (the Software) are exclusively owned by FlipBuilder.com. For
more information, visit our website at www.Flipbuilder.com .

Anyone may use this software but all the page-flipping eBooks generated will automatically
have a demo watermark on the first page of them. To remove the limitation you must
register.

Once registered, the user is granted a non-exclusive license to use the Software on one
computer (i.e. a single CPU) at a time. The registered Software may not be rented or leased,
but may be permanently transferred, if the person receiving it agrees to terms of this
license.

The Software unregistered (trial) version may be freely distributed, provided the distribution
package is not modified. No person or company may charge a fee for the distribution of the
Software without written permission from the copyright holder.

THE SOFTWARE IS DISTRIBUTED "AS IS". NO WARRANTY OF ANY KIND IS EXPRESSED OR
IMPLIED. YOU USE AT YOUR OWN RISK. THE AUTHOR WILL NOT BE LIABLE FOR DATA LOSS,
DAMAGES, LOSS OF PROFITS OR ANY OTHER KIND OF LOSS WHILE USING OR MISUSING THIS
SOFTWARE.

You may not use, copy, emulate, clone, rent, lease, sell, modify, decompile, disassemble,
otherwise reverse engineer, or transfer the licensed Software, or any subset of the licensed
Software, except as provided for in this agreement. Any such unauthorized use shall result in
immediate and automatic termination of this license and may result in criminal and/or civil
prosecution.

All rights not expressly granted here are reserved by A-PDF Solution.

Installing and using the Software signifies acceptance of these terms and conditions of the
license.

If you do not agree with the terms of this license you must remove the Software files from
your storage devices and cease to use the product.
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How to Order

Order Online (http://www.flipbuilder.com/flip-pdf-pro/index.html) or Order Toll Free

1-877-353-7297 (When you order toll free just give the operator the product number of the
product you would like).

How to purchase online?

1. Select a license type above, and click [Buy Now]

2. Select the currency that you want to use. (You can also continue shopping)

3. Fill billing information and select a payment method. (Your information is safe with us)
4. Check the information you filled previously and click "Place Secure Order"

Other Order Ways—With Phone/Mail/Fax/Check:

If you are not comfortable ordering online witha credit card, you are welcome to choose an
offline order option in the payment section of the order process. We accept mail, fax, wire,
and PO (if applicable) ordering options in addition to ordering online. We also provide
phone orders through our 24x7 order desk at 1-877-353-7297, or (952) 646-5331 for
International Callers.

Please note that all of the offline ordering options do have additional fees for processing. To
place an order by mail, fax, wire, and PO (when applicable), use the online form and then
choose one of these payment options found in the Payment Method section of the form.
Once submitted online, the appropriate information will be provided to you in your web
browser to send your payment to us offline.

100% unconditional 30 Day Money Back Guarantee

Want to custom the program or have other questions about purchase?
Contact us at alice@flipbuilder.com .
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Support

You can easily search or browse our frequently asked questions, and learn tutorials about
products, and get your registration code back. If you are not satisfy with the solutions
provided, please contact support team for help.

1. Frequently Asked Questions

You can find answers to questions about technique issues here:
http://www.flipbuilder.com/support/list-Flip-PDF-pro

2. Learn tutorial about Flip PDF Pro

We publish a video tutorial which shows you the easy procedure of dealing with Flip PDF Pro,
you can view this video to quickly handle the stunning tool:
http://www.flipbuilder.com/demo/flip pdf pro.swf

3. Get lost license code

Click here to look up the order » (http://www.regnow.com/cs/orderStatus)

You can pull up a copy of your order by entering your email address. After you find your
order, you may view its status, view details of your order (including the license key), and
obtain the invoice.

4. Contact Us

If you have other questions or requirements, contact us directly through our support Email:
alice@flipbuilder.com, we will respond you ASAP.
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